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Participants
This course is aimed at:

• Users of EXO Business.

Prerequisites
Basic PC experience is required.

Understanding of business processes and procedures.

Instructional method

The instructional method combines trainer-led demonstrations with hands-on student 

practice. You will work through a series of examples. Each unit concludes with a Review 

Task. 

Conventions used in this manual

• Objects such as buttons or icons that you must click or select are shown in bold.

• Information to be entered (typed in) is shown in bold and italics.

• Keyboard keys are shown as , , etc.

Screenshots in this manual are for illustration purposes only and may differ from those in 

the actual product due to configuration settings.
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Symbols used in this manual

Symbol Name This symbol tells you... 

Practice task

Review task

… to complete a task to practice the skills you 

have just learnt, or as a review task at the end 

of the unit to consolidate what you have learnt.

Written Review task … to complete written questions to review the 

content covered in the unit.

Optional Challenge … to complete this task if you have finished 

early and are looking for an extra challenge.

Tip … about helpful tips

Note … to take note of an important message.

Warning … about potential problems to be aware of.

Important … to pay attention to an important notice.

New … where features are new for <<Product Name>>.

Reference … where to go to find more information.

Skills Checklist … to tick off a list of skills that you have learnt 

during the unit.
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Objectives

As EXO Business is highly customisable, we have focused the learning content on those 

processes which are generic to most implementations. This training course is intended to 

support the customised training offered by your implementing partner.

Upon completion of this course you will be able to:

• Open an EXO Business database

• Search for and access transactional information

• Manipulate EXO Business views using ExoGrid

• Enter Debtors, Creditors and Contacts

• Utilise the Task Scheduler to manage daily business activities

• Print, view and export standard reports using Clarity Report Browser and Dashboards
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Navigational & Function Keys

MYOB EXO Business can be navigated by keyboard or mouse, however a combination of 

both is generally used. The standard keyboard convensions for Windows are used, with a 

few MYOB EXO Business-specific options.

Windows Navigation Keys

TAB Moves from field to field, column to column

SHIFT+TAB Moves backwards from field to field, column to 

column

ENTER On open dialogue boxes, automatically select the OK 

button.

ARROW KEYS Moves around a grid, or up and down a list.

PAGE UP, PAGE DOWN Moves between the “sections” of some screens, 

such as moving from the invoice header to the body 

to the end.

ALT + (Underlined Letter) ALT key plus the underlined letter on a field label 

activates that function, e.g. ALT + N within a the 

debtor account screen creates a New Debtor.

MYOB EXO Business Function Keys/Shortcut Keys

F1 HELP

F3 Debtor accounts search screen

F4 Sales Order search screen

F6 Debtor Invoice entry screen

F7 Invoice Number search screen

F9 Enter sales message (within an order/invoice)

F10 Alternative delivery address (within and order/invoice)

RIGHT + CLICK Right-click on Exogrid header or certain field to acces additional 

functions or options.

CTRL + 0 Create one-off stock items (within an order/invoice)

CTRL + L Stock level enquiry (within an order/invoice)

CRTL + N New line narrative (within an order/invoice)
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Shortcut Menus
A shortcut menu is available at the top of the main window of each EXO Business module. 

This menu offers quick access to commonly used functions, e.g. accessing the Debtors 

Masters, accessing the Stock Masters, creating a new Sales Order, etc. Any menu item that 

has a shortcut key assigned will automatically appear in the shorcut menu.

Shortcut Menus
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Product Overview

In this unit you will learn 
the basic functionality to 
navigate and locate 
account information.

By the end of this unit, you will be able to:

 Demonstrate understanding of the key features 

of MYOB EXO Business
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Overview

On completion of this module participants should be able to:

• Demonstrate understanding of the key features of MYOB EXO Business.

• Select and open EXO Business databases

• Be familiar with the menu structure and account masters

• Search for and access transactional information

• Navigate EXO Business using function keys

• Manipulate EXO Business views using ExoGrid

• Utilise the Help functions in EXO Business.



© Copyright 2013 MYOB Technology Pty Ltd

Getting a head start with EXO Business EXO Business

 4

Unique Features

EXO Business enables organisations to keep growing with the support of a dynamic, 

flexible and robust business information system. While it is simple to use and highly 

configurable, it has some key differences to many other accounting systems. Those of you 

moving onto MYOB EXO Business from products such as MYOB Premier will need to be 

aware of these differences:

A period based system:
While many accounting systems are date based, EXO Business is period based, with a 

financial year usually being divided into 12 periods with 1 calendar month per period.

Critical procedures such as transaction ageing and posting between ledgers all refer back 

to the nominated period, while most of the standard reports in EXO Business use periods 

to calculate totals.

Transactions must be posted to the General Ledger
The Debtors, Creditors and Stock ledgers are integrated with the General Ledger, however 

transactions must be posted to the General Ledger manually. This is usually conducted as 

part of the month end procedures.

Reports are fully customisable
Reports can be customised via the Clarity Report Designer and most reporting can be 

period based or date based.

The current period is 0 (zero)
Last month is Period 1, two months prior is Period 2, etc.

Transactions can be posted back
EXO Business allows transactions to be posted back to a prior period, however it does not 

recognise future periods. This means that transactions can only be posted to prior or 

current periods.

Current 

Month
Period 0 Period 1 Period 2 Period 3

August 2013 August 2013 July 2013 June 2013 May 2013
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Data is highly accessible
EXO Business’s report writer (Clarity) provides many standard reports which can be 

customised. In addition stored data can be easily extracted for detailed analysis (for 

example into Excel using ODBC links).

Data is always available:
Data is not purged at year end so historical comparisons are readily available.

Drill down to data
From almost anywhere in EXO Business, you can ‘‘drilldown’’ by double clicking on a 

linked item to access additional information.

High level Security with Customisable user access
Users can be given permission to access all or parts of the system, depending on the 

operational requirements of the business. Menus can also be customised to suit the user. 

Generally in your business you will only be given permission to access the parts of the 

software that you need to undertake your job.
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How is information stored?

Transactions
Most business activity is recorded via transactions that deal with stock, suppliers and 

customers, such as:

• Purchasing stock items and services

• Making payments to suppliers

• Entering sales

• Receiving payments from customers

In EXO Business these functions are called transactions. The transactions are best 

explained in the context of a cycle. Purchasing and paying for items is the equivalent of 

the Purchasing Cycle. Selling goods and receiving payments is the equivalent of the Sales 

Cycle. These are explained in the relevant training modules.

Information about these transactions can be found in the sub-ledgers and, following 

certain end of month procedures, in the General Ledger.

Information flow EXO Business
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Sub-Ledgers
Transactional information can be accessed via the following sub-ledger accounts:

Debtors (Customers)

Information on sales, payments received, debtor adjustments.

Creditors (Suppliers)

Information about purchases, payments made, creditor adjustments.

Stock

Information about stock levels, current orders, sales and purchases and adjustments.

Information about the accounts and the transactions the business has undertaken is 

grouped on tabs within each main account. We will be looking at the individual accounts 

and the information that they hold later in this module.

General Ledger
The General Ledger is a group of accounts that provide a summary of the transactions that 

have been carried out via Debtors, Creditors and Stock. In addition, transactions can be 

entered directly to the General Ledger via Integrated Cashbook and General Ledger 

Transaction entries.

Sample transaction: Sell motor oil to customer.
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Information from the General Ledger is used to review business performance and prepare 

key financial statements such as Profit & Loss reports, Trial Balance, etc.

Sample Transaction: post to General Ledger
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Accounting Periods

As discussed, EXO Business is a period-based accounting system. While transaction dates 

are recorded for reference purposes, it is the period to which a transaction is posted that 

determines when it is reflected in the financial statements.

In accounting terms, periods determine the intervals at which the financial statements will 

be prepared. Most commonly periods reflect the calendar months, however this can be 

varied to suit your business.

End of Period
The end of period is the point in time where we total the transactions that have occurred 

in order to determine the profitability for the period (Profit and Loss) and the net worth of 

the business (Balance Sheet). MYOB EXO Finance handles this via the End of Period roll.

Posting
Posting is the process of telling EXO Business which period you want the transaction to 

belong to.

Once a period has been rolled via the End of Period process, it is still possible to post 

transactions to prior periods. However transactions cannot be entered into a new period 

until an end of period is performed (i.e. you cannot post to future periods).

The End of Period is a defined and structured process.
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Starting EXO Business

The EXO Business training database is installed on your training workstation.

To log in to an EXO Business database:

1 Double-click the EXO Business shortcut icon on your desktop. You will be presented 

with the login dialog as follows:

2 Type in the ExoAdmin password (ExoAdmin). 

I M P O R T A N T

Usernames and Passwords in EXO Business are case sensitive and must be entered exactly 

as set up in order to successfully log onto a database.

3 Click OK. 

4 You should now be at the EXO Business main screen, which defaults to the Task 

Scheduler window.

EXO Business Login screen
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Choosing the Correct Database
If you have only installed the demo database, you will have one database available to 

connect to, the EXO Business_demo (MotoPartz).

If you are working within an existing installation, there may be more than one database 

available to connect to. A number of databases can be installed to enable testing of 

various advanced functions (such as price updates, etc.).

In the Connect to: field, make sure that the correct database is selected before logging in.

W A R N I N G

Each time you log into EXO Business make sure that you are logging in to the correct 

database by selecting the correct name from the drop down list.

I M P O R T A N T

When undertaking transactions in a test database, make sure you log out as soon as the 

testing is complete. It is essential that you be aware of the database you are working in 

(hover over the company name in the status bar to check the connection string that you 

are using.)

EXO Business Task Scheduler screen
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T I P

You can check your current login details by choosing About from the Help menu.

EXO Business Help > About screen
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EXO Business Menus

The EXO Business menu has been designed for users to easily navigate from one part of 

the database to another via a screen based menu system. Icons are used to identify 

different parts of the system. Click on one of the nine menu icons to view the options 

available.

Depending on your user profile, you will have access to some or all of these menus when 

using your own database.

EXO Business menu icons

Menu Icon Description

Task Scheduler

The Task Scheduler enables you to create and view tasks, set 

reminders and establish recurring appointments. Tasks created 

in the scheduler can be viewed in the task lists of individual 

debtor or creditor accounts.

Sales

The Sales screen is for recording sales orders, invoices, receiving 

payments, and creating statements. You can also maintain the 

debtor accounts and contacts from this screen.

Purchases

The Purchases screen is for recording purchase orders, receiving 

and costing goods and creating creditor invoices. This screen also 

provides access to creditor payments, creditor adjustments and 

the creditor payments processor.

Stock

The Stock screen allows you to maintain stock items, run stock 

takes, track serial numbers and enter stock adjustments. It also 

enables the establishment of Bills of Materials (order templates, 

kits and builds) and works orders.

General Ledger

The General Ledger screen is for reviewing GL accounts, bank 

reconciliation, integrated cashbook entries and tax reporting 

functions. It also enables review and editing of existing batches.
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Drop Down Menus
The menu items available on each of these screens are also accessible via the drop down 

menus at the top of the EXO Business screen. Many menu options also have 

corresponding function keys, some of which are outlined in ‘Navigational & Function Keys’ 

on page vii.

N O T E

Drop down menus and screen menus may vary depending on your user profile. Not 

everyone will have access to all functionality. Menus and screens can be further 

configured.

N O T E

Available shortcut menus may vary depending on your user profile. Not everyone will have 

access to all functionality.

End of Month

The End of Month screen facilitates end of period processes such 

as posting sub-ledgers to the GL, debtor statements, exchange 

rate variance calculations, and rolling the end of period. Access 

to this screen is generally limited to only a small number of 

experienced users within an organisation.

Reports

The Reports screen provides access to the EXO Analytic 

Dashboards and Widgets, enables viewing of all available reports 

via the Clarity Report Browser (reports specific to a particular 

functionality, i.e. sales, are available via the Reports button on 

that screen). General Ledger report batches and graphs as well as 

the Sales Analysis Designer can also be run from the reports 

screen.

Utilities

The Utilities screen provides access to more advanced functions 

such as setting up staff, account groups, stock groups and pricing 

as well as audit trail reports. 
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Searching

All search screens follow a common style, whether you are searching for sales orders, 

invoices, creditors, etc. 

Example:

Click on the Sales screen icon and then on any of the relevant buttons to search, i.e. 

Maintain Debtors, Maintain Contacts or Invoice Search.

To search for a debtor account:

1 Click on the Sales screen and then click Maintain Debtors. This will return a list of all 

active debtors.

2 To narrow the search, enter part of the name in the Search key field. This can be 

either all or part of the debtor name, debtor code or A/C No.

Debtor Account search screen
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3 Select any other checkboxes relevant to the search. For example, Extended Search 

searches more fields (such as address, or extra reference fields), however it is 

marginally slower. If Extended Search is not selected, only basic fields are searched 

such as A/C No, Code and Name.

4 Click Search. This returns a list of items that match the search criteria.

T I P

The stock search function enables you to search on either the ‘‘Exact Phrase’’, ‘‘All Words” or “At 

least one”.

To select an item and view more detail (‘‘drill down’’), double-click on the item using the 

mouse. This will open the debtor account screen for that debtor.

T I P

Accounts with a current balance will appear blue, while those with no current balance are black. 

Accounts with an outstanding balance will appear in red.

Advanced Debtor Search
Advanced search is available from the Debtor Search screen (File > Advanced Search). This 

is useful for more specific searches, such as ‘‘Balance is greater than $500’’ or ‘‘Address3 = 

Sydney’’ as shown below. Multiple conditions can be established to highlight specific 

debtors, as in the following example.

Searching within transaction screens:
•  or  from within a required field will return a complete list. 

• Type any part of the name/code you are searching for and then press Enter to return 

a list that matches the parameters set.

Advanced debtor search screen example
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T I P

When searching for a specific item from within a transaction entry grid, enter a ? and press  

to return all items in the list. Partial searches can be made by typing in part of the word (e.g. MAR will 

return all items containing MAR.)

Example:

Enter FIL in the stock search screen of the training database will return stock items with 

the letters FIL anywhere in the code or description, as shown in the example below.

Stock search example
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Exogrids

Exogrids are used throughout EXO Business to display, search and sort data. Exogrids are 

active on most screens where you are viewing current transactional information (debtor 

accounts, stock items, etc), however they are not active on the transaction entry screens 

(ie. new sales order).

N O T E

Custom filters and ordering of columns are unique to your workstation and will not appear 

when working on a different user’s workstation.

To manipulating exogrids:

T I P

Hold down the SHIFT key while clicking on a second column facilitates multiple sorting (e.g. sort by 

Primary Group, then by Name.)

Exogrid options on the Debtor Account screen
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Action Description

Sort the Grid Click on a column header name to sort by that column 

(in ascending order). Click on the column a second time 

to reverse sort. You should see a small black triangle 

indicating the column that you are sorting on.

Restructure the Grid Click and drag in the column header to re-order the grid 

(e.g. move NAME to be the first column in the grid).

Open an Item Double-click on the line item.

Display Line Options Right-click on the grid body to display options related to 

the line selected (e.g. reverse a transaction, print a 

document).

Display Grid Options Right-click on the blue header line of the grid (subject to 

option support)

• Save column settings - retains the current 

settings for this grid on this workstation.

• Hide this column - a quick method for hiding 

the column that you have selected.

• Restore default column settings - resets all 

changes back to the ‘factory default’.

• Select visible columns - determines the 

columns to display in the grid. Some optional 

columns are not enabled by default, as they 

may not suit all users.

• Find - prompts for search text, and searches 

the grid for a matching entry.

• Grid ordering - provides two options, to ‘Lock 

Grid Ordering’ or to ‘Revert to Natural 

Order’. This prevents automatic reordering 

when keying-in transactions.

• Copy to clipboard - copies the contents of 

the visible columns to the Windows 

clipboard, to be pasted into a spreadsheet or 

similar application (using the Edit > Paste 

menu in most applications).

• Custom filter - advanced option to apply 

custom SQL statements to the grid. See your 

implementing partner if you want this 

functionality activated.
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N O T E

If you make changes to an Exogrid that you want to retain, choose Save Column Settings. 

This will apply to the workstation you are working at.

Saving Window Sizes and Positions
When resizing or repositioning windows, it is possible to save these settings for next time 

you open a particular window.

To save/restore the window size and/or position:

1 Right-click on the window’s title bar or press ALT+SPACEBAR.

2 Select Form Position > Save. This will save the window at that size and position for 

next time you open it. The window can subsequently be resized as often as required 

and will reopen with the saved settings.

3 Select Form Position > Restore to restore the default MYOB EXO Finance settings.

Saving window positions and sizes
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Help Functions

There are a number of ways to access help when using EXO Business.

These include:

On-line help
This can be accessed from Help > On-line Manual or by pressing F1. Your help file should 

be installed on the help directory specified in the Exoconfig profile (usually C:\Program 

Files(x86)\MYOB EXO Business\Help).

The On-line help function offers a comprehensive, indexed guide to most Exo Business 

functions designed to support you in your day to day use.

Tool Tips
Tool Tips are shown when hovering the mouse over an icon, a section, an option or a 

setting.

Screen help
Screen help is shown at the bottom of most screens and can be turned off and on by 

clicking the  button on the top right side of the screen.

Whitepapers and Quick Guides
A number of Whitepapers and Quick Guides have been written for MYOB EXO Business to 

address various topics on the system. These offer a high level of technical and some 

procedural detail and are available to Accredited MYOB Exo Business Consultants.
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Select and open EXO Business Databases

Search for and access transactional information

Navigate using function keys

Manipulate views using ExoGrids
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Account Masters

In this unit you will learn 
the basic functionality to 
create and edit Debtors, 
Creditors and Contacts 
master records.

By the end of this unit, you will be able to:

 Enter debtors, creditors and contacts

Use account tabs to record additional information

Utilise the Task Scheduler to manage daily 

business activities
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Overview

On completion of this module participants should be able to:

• Enter debtors, creditors and contacts

• Use account tabs to record additional information

• Utilise the Task Scheduler to manage daily business activities
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Overview of Account Masters

In EXO Business information is recorded in four different ledgers:

• Debtors Ledger (Customers)

• Creditors Ledger (Suppliers)

• Stock Ledger

• General Ledger

These are referred to as the Account Masters.

Information about accounts within each of the ledgers (i.e. a stock account or a debtor 

account) is grouped on tabs within the account.

Essential information is on the first tab (Details 1) while additional information is stored 

on the following tabs (Details 2, Contacts, Transactions, Orders, Extra Fields, History 

Notes, Documents, Activities, Analysis, etc). These vary slightly depending on which of 

the Account Masters is being viewed.

A summary of the tabs of each of the account masters follows. This is an overview only 

and more detail is provided in later modules.

T I P

To search for a Debtor, Creditor, Stock Item or Non-Account, type? followed by the  key. This 

will display a list of relevant records to choose from.

When accessing a list of all accounts, Account Types are also colour coded: 

• Debtors = green

• Creditors = red

• Non-Accounts = black.

Example of tabs on the debtors master
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Debtors Master

Accounts > Debtors

Debtor account management within EXO Business is very powerful. Debtor accounts can 

be grouped to suit the reporting requirements of the business and the account master 

contains all the information related to the account, e.g. debtor details, contacts, 

transactions, notes, price policies, etc.

Debtor accounts can be found via Maintain debtors on the Sales screen.

Details 1 tab
Contains primary information such as addresses, key contacts, sales and credit 

information, price setup, account type flag and other system maintained information.

T I P

Icons at the top of each of the account screens provide specific functionality and will change when 

moving between tabs.

N O T E

The contact name on the Details 1 tab is the default contact for the account. It must be 

setup as a contact and then assigned as the Default Contact via the icon on the Contacts 

tab. A separate contact can be set up for statements on the Details 2 tab.

Debtors Master: Details 1 tab
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Details 2 tab
Holds secondary information including payment information (i.e. prompt payment 

discounts), banking details, tax registration, auto order template, invoice format control 

(i.e. which invoice format to use when printing invoices for this customer), which method 

is used to send statements, who statements are sent to, social media details and pop up 

alert text.

I M P O R T A N T

Only contacts with valid email addresses can be selected as the Statement Contact.

Contacts tab
Provides the debtor’s contact details. Users can add, delete or edit contact information. 

Users can easily create documents for the contact person, and an email facility is also 

supported on this screen.

Transactions tab
Users can view all transactions related to the debtor, e.g. payments, invoices, credit notes, 

adjustments, and allocations. Each transaction provides details related to the transaction 

such as the date, kind of transaction and the amount. Users can also drill down to show all 

General Ledger transactions associated with the selected transaction. Invoices and 

statements can also be emailed from this tab.

N O T E

An option Preview Journals is available. Selecting this option opens up the GL Batch 

Transactions window, showing all General Ledger transactions that will be generated for 

the selected Debtor transaction.

Orders tab
Allows viewing of the sales orders for this debtor, status and order amount. New sales 

orders can also be created from this screen.

Extra Fields tab
Debtor accounts supports 24 extra fields that can be defined to suit the company needs. 

The first 3 extra fields are displayed on the Details1 tab and the rest on the Extra Fields 

tab.
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Serials tab
Shows a list of all serialised stock items that were purchased by this account. 

Discounts/Prices tab
This page displays all the price policies and price rules that apply to this account.

Jobs tab
Displayed when the Job Costing module is installed, this tab lists all jobs related to the 

account. It displays the jobcode, job no., status, order no. and start and due date.

Notes tab
This tab provides a ‘free-form’ way for users to record any communication or general 

information related to the debtor. Users can insert the username and date/time when the 

info is recorded and common phrases can be entered easily. This is a very useful tool for 

entering conversations and events relating to the debtor.

History Notes tab
This is like the notepad tab, but is more structured. This makes it easier to search for 

previous notes related to the debtor. You can create, edit, delete, or email history notes 

depending on your user profile.

Documents tab
Lists all the documents related to a debtor account. It could be a word processing 

document, a graphics file, or any document that is recognised by a Windows application. 

When sending e-mails from EXO Business, users have the option to save a copy of the e-

mail in the corresponding debtor’s Documents tab. E-mails from Microsoft Outlook can 

also be dragged and dropped into the Documents tab.

Analysis tab
Displays a graphical view of the sales performance and allows comparison of the sales 

through the year.

Relationships tab
Shows existing relationships for the debtor account and provides for the establishment of 

new relationships.
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Opportunities tab
Shows a list of all the opportunities associated with this debtor account.

N O T E

Opportunities are part of the functionality available with EXO CRM. The Opportunities tab 

can be added to the Debtor Account maintenance to enable users to use this functionality 

from within EXO Business core. However, an EXO CRM license will be used by each user 

that has access to this functionality from within EXO Business core. 

Activities tab
Shows a list of activities relating to the debtor account and enables addition of new 

activities through the  icon.

Serviceable Units
Shows a list of all Serviceable Units assigned to this debtor account.

N O T E

Serviceable Units is only available with EXO Job Costing. Refer to the EXO Job Costing User 

Guide for information on Serviceable Units.

Social
Shows information about the debtor from various social media services. If no social media 

details have been entered on the Details 2 tab, the sub-tab will display the results of a 

search for the debtor. 
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Creditors Master

Account > Creditors

The creditor accounts master is very similar to the debtors master. Users can set up 

creditor account groups suited to the recording and reporting requirements of the 

business.

Details 1
Contains company details, purchases and credit information, account type flag and other 

system maintained information.

Details 2
Holds payment info including prompt payment and vendor discount, the method for 

sending remittances and who they are sent to, banking details, default GST rate, which 

method is used to send remittance advices, maximum auto authorise amount, social 

media details and pop-up alert text.

I M P O R T A N T

Only contacts with valid email addresses can be selected as the Remittance Contact.

Creditors Master Details 1 tab
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Contacts
Provides the creditor’s contact details. Users can add, delete or edit contact information. 

Users can easily create documents for the contact person and an email facility is also 

supported on this screen.

I M P O R T A N T

There can only be one default contact per creditor and the default contact cannot be 

deleted. 

Transaction
Users can view all transactions related to the creditor, e.g. payments, invoices, refunds, 

adjustments, allocations, etc. Each transaction provides details related to the transaction 

such as the date, kind of transaction and the amount. Users can also drill down to show all 

General Ledger transactions associated with the selected transaction. 

N O T E

An option Preview Journals is available. Selecting this option opens up the GL Batch 

Transactions window, showing all General Ledger transactions that will be generated for 

the selected Creditor transaction

Orders
This is where you can view a list of purchase orders on their account, their status and 

order amount. New purchase orders can also be created from this tab.

Serials
This shows a list of all serialised stock items that were bought from this account.

Notes
Allow users to record any communication or general information related to the creditor. 

Users can insert the username and date/time when the info is recorded and common 

phrases can be entered easily.

History Notes
This is like the notepad tab, but is more structured. This makes it easier to search for 

previous notes related to the creditor. You can create, edit, delete, or email history notes 

depending on your user profile.
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Documents
Lists all the documents related to a creditor account. It could be a word processing 

document, a graphical .gif or .avi file, or any document that is recognized by a Windows 

application. When sending e-mails from EXO Business, users have the option to save a 

copy of the e-mail in the corresponding creditor’s Documents tab. E-mails from Microsoft 

Outlook can also be dragged and dropped into the Documents tab.

Analysis
Displays a graph that gives a quick view of the purchases performance, and comparison of 

the purchases through the year. This will help to forecast future purchases.

Relationships
Shows existing relationships for the creditor account.

Opportunities tab
Shows a list of all the opportunities associated with this creditor account.

N O T E

Opportunities are part of the functionality available with EXO CRM. The Opportunities tab 

can be added to the Creditor Account maintenance to enable users to use this 

functionality from within EXO Business core. However, an EXO CRM license will be used by 

each user that has access to this functionality from within EXO Business core.

Activities
Shows a list of activities relating to the creditor account and enables addition of new 

activities through the New Task icon.

Social
Shows information about the creditor from various social media services. If no social 

media details have been entered on the Details 2 tab, the sub-tab will display the results 

of a search for the creditor. 

W A R N I N G

If a Creditor is set up as a main supplier for a stock item, the Creditor cannot be deleted 

from the system.
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Stock Master

Account > Stock

Details 1
Contains stock item code, description, groups, cost and sell prices, unit of measure, serial 

no. tracking method and stock levels per stock location.

N O T E

Serial numbers, batch codes and support for expiry dates are optional settings.

I M P O R T A N T

Goods can be restricted by using the Restricted Goods option. You can restrict goods at 

stock code, debtor account, head office, location, branch, sales person or staff member. 

Details 2
Holds the min/max stock, sales, purchase and COS GL codes, weight and cubic info, sales 

and purchase GST and the barcode and alternate suppliers and codes.

Stock Master Details 1 tab
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T I P

Extra columns such as bin code and min/max quantities can be shown on the stock location summary 

on Details 1 by using Exogrid visible columns function (right-click on a column).

Transactions
Contains a list of transactions for the particular stock item, e.g. invoices, orders, receipts, 

adjustments, and transfers. Users can also drill down to show all General Ledger 

transactions associated with the selected transaction. 

N O T E

An option Preview Journals is available. Selecting this option opens up the GL Batch 

Transactions window, showing all General Ledger transactions that will be generated for 

the selected Stock transaction

Orders
Displays the orders related to the stock item. It contains three panels: sales orders, 

transfer requests and purchase orders.

T I P

Panels on the Orders tab can be hidden or viewed by going to the View menu and deselecting or 

selecting the relevant grid.

Works Order
This tab is divided into two panels; one for works order to be produced and works order to 

be used in production.

Web
Contains fields that you need to use if you are displaying your stock on a website.

Notes
Allows entry of ‘free-form’ notes pertinent to the stock item.
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History Notes
This is like the notepad tab, but is more structured. This makes it easier to search for 

previous notes related to the stock item. You can create, edit, delete, or email history 

notes depending on your user profile.

Documents
Lists all documents related to a stock account. It could be a word processing document, a 

graphical .gif or .avi file, or any document that is recognised by a Windows application. E-

mails from Microsoft Outlook can also be dragged and dropped into the Documents tab.

Analysis
A quick preview of the sales status of the stock item. The graph displays the dollar value 

(depicted through a red line). Double-click on the graph to view the total units sold (blue 

line).

N O T E

Activities cannot be entered via the stock accounts. Notes or history notes can be used to 

enter additional information into the stock accounts.
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General Ledger

Account > General Ledger

The General Ledger (GL) is the consolidation of all the movements created in the debtors, 

creditors and stock sub ledgers. GL accounts are used to prepare financial reports at the 

end of each period and each financial year.

N O T E

Period totals for a Profit & Loss account show account movement for the period while 

Balance Sheet totals show accumulated balance.

Details
Contains general ledger account no, name, report code, account group, default GST rate 

and flags. It also identifies the type of GL account and the currency used. When selecting 

the Account Group, the system will default to debit/credit and Balance Sheet/Profit and 

Loss as set up in the Account Group.

W A R N I N G

When creating a General Ledger account the account group will default to the first group 

on the dropdown list. This must be changed to the correct account group.

The Allow journals option can be set at the GL account level for all sub-accounts or can be 

set independently at each subaccount level.

General Ledger Sales Account
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Transactions
Lists all the transactions that match the search criteria. Users can also drill down to show 

all GL transactions associated with the selected transaction. 

N O T E

General ledger transactions can be grouped. When grouping is enabled, the transactions 

grid displays totals for each combination of grouping properties

Budget
Allows multiple budgets to be set up and used for reporting purposes. 

N O T E

Budget and sub-accounts tabs are only visible once the GL Account is created and saved.

Notes
Allows entry of ‘free-form’ notes pertinent to the GL item.

History Notes
History notes provide for structured note taking. History notes can be created, edited, 

deleted, or emailed depending on your user profile.

Analysis
Show trends of a particular account in graphical form.

W A R N I N G

General Ledger Accounts can only be deleted from the system if there are no transactions 

against the account. If a General Ledger Account is used in a Recurring or Suspended 

General Ledger Batch it must be removed from the batch before it can be deleted.
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Set up a New Debtor (Customer)

Account > Debtors

The process for setting up a new debtor is relatively straightforward, however you will 

need to consider a number of additional factors such as what groups they will be in, the 

base selling price they will incur, etc. 

To set up a new debtor

1 Press F3 to open the debtor search screen, or navigate via the drop down menus 

Account > Debtors.

2 Click New to create a new debtor entry screen (ALT+N).

New Debtor: Details 1
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Details 1
1 Enter Primary Details:

2 Review account flags checkboxes:

Section Description

Account name & Code EXO Business will generate a code based on the name that you 

give the debtor.

Company and Postal 

Address

Ensure that you enter the details in the correct fields (use the 

return key). If you choose not to enter a separate delivery 

address, then the postal address will be replicated once the 

debtor account is saved.

Note: Remember to enter the Postcode in the correct field to 

facilitate searching and sorting of debtors

 E-mail, Phone, Contact 

name

To enter a contact name on the Details1 screen, a contact 

must first be entered into the contacts tab. Then click the icon 

Set to default contact in the menu bar. See the next section 

‘Working with Contacts’ on page 45 to review the procedure 

for adding a contact.

Note: The contact name on the Details 1tab is the default 

contact for the account.

Sales Groups Primary and secondary sales groups are set up when 

implementing the program. Ensure that you select the correct 

ones so that business reporting and marketing activities are 

based on accurate information.

Credit terms The credit terms available are also set up when implementing 

the program. Choose the appropriate period and credit limit 

required.

Currency Enter the currency from the drop down list.

Note: Currency must be correct at the time of entering a new 

debtor as currencies cannot be changed once the debtor has 

been saved.

Section Description

Active Select to make account active.

Open Item Select to allow payments against specific invoices, not final 

balance.

Stop Credit Enables you to put this account on stop credit.

Account Template when creating a new order for this account, it will use the 

Auto Order Template specified in the Details 2 tab.
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Details2 tab

1 Enter Secondary Details:

Allow Restricted Goods allows this particular account to purchase goods that may be 

restricted (e.g. hazardous materials that may require the 

purchaser to be licensed). Restricted goods status is assigned 

in the stock master.

Private Account checkbox restricts access to the assigned salesperson only.

New Debtors Details 2 tab

Section Description

Payment Details

Default payment type When receiving payments, this will be the payment type 

that the system defaults to. It can still be changed at the 

time of receiving payment.
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Bank Details Bank details are only required here if you are using the 

direct debits module. Cheque details are recorded on the 

payments screen and are not kept on the debtor account. 

However the cheque details are retained for the next time 

a cheque is received from that debtor.

Advice Notification Select the method you wish to advise the Debtor of the 

payment made.

Prompt Payment

Discount(%)/Amount Enter in either the discount % or amount applicable for 

this debtor for prompt payment.

Do Not Accept Cheques Will you accept a cheque from this Debtor for payment of 

invoices.

Social Media

Facebook, LinkedIn, 

Twitter

Enter account ID from social media services for the 
debtor.A search for the account ID can be made from 
the Social tab on the Debtors Account once the new 
Debtor has been saved.

GST Details

ABN The ABN should be entered at the time of setting up the 

debtor account.

NOTE: MYOB EXO Business will not remind you if the ABN 

 not completed.

Override GST rate It is recommended that the GST rate is left at 1-auto 

Select rate unless it is an international debtor that will not 

attract GST. This will utilise the default rate set for 

debtors that has been set up. 

Miscellaneous Details

Auto Order Templates Provides access to predefined lists of commonly ordered 

items that will automatically populate a new sales order 

for this customer. If a template is not chosen, a blank 

invoice will be created.The template is created in Bill of 

Materials.

Invoice Files If you wish to use multiple Invoice formats for Debtors, 

enter the invoice number to be used for this debtor. Entry 

will generally be 0, 1 or 2 depending on how many invoice 

files you have setup for your organisation.

Statement Delivery From the dropdown list, select the method by which 

statements will be delivered (None/Email/Print/Both).

Statement Contact From the dropdown list, select the contact to which 

statement will be e-mailed if the Statement Delivery is 

set to Email.
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Extra Fields
1 Ensure that the required information is entered in the Extra Fields tab. These are 

generally additional customised fields set up for you by your implementing partner 

to suit the requirements of your business.

Save the new debtor by clicking the Save button. This will save the details you have 

entered and provide access to the transactional fields on the debtor account (such as 

transactions, orders, activities, etc).

Invoice Type From the dropdown list, select the type of invoice that 

will be used for this debtor:

• Select Default for the default invoice layout.

• Select Standard for the Clarity invoice layout.

• Select M-Powered for the M-Powered invoice 

layout.

Pop-up Alert

Pop-up Alert Enter in a Note you wish to be displayed anytime this 

Debtor is selected in Exo Business (e.g. on a sales order).
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Working with Contacts

Contacts add an element of flexibility when dealing with customers and suppliers. 

Contacts are entities in their own right and do not have to be linked with a Debtor, 

Creditor or Non-account.

• An individual contact can be linked to one or many accounts if required.

• One debtor or creditor account can have many contacts if required.

• Relationships can be defined between contacts as well as between contacts and 

accounts. 

• Activities (Tasks/Appointments) can be recorded against contacts.

This section provides details on some of the more commonly used features when dealing 

with contacts.

Search for a contact

To search for a contact:

1 Open the contacts screen: Account > Contacts.

2 From the Views dropdown list, select a pre-defined filter, e.g. Sydney-based 

contacts. See ‘To create a custom view:’ on page 46 for instructions on creating 

Views.

Account Contacts search screen
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3 From the Contact List dropdown list, select a pre-defined contact list. 

N O T E

Contact Lists is a feature of EXO CRM and requires an EXO CRM license. Refer to the EXO 

CRM User Guide for more information on Contact Lists.

4 Enter appropriate search information in the search field (e.g. part of the surname).

5 To filter on specific marketing profiles, select the option Marketing Profile and 

select the respective profiles in the dropdown list. See ‘Other contact information’ 

on page 49 for instructions on creating Marketing Profiles.

6 The Extended Search option is unselected by default. This searches for the Search 

string in the address, email, phone number and linked debtors fields, as well as the 

contact name. If you have a small database, or want to extend your Search to 

beyond contact name,select this option.

7 Select the Active option if you only want to search active contacts only.

8 Click on the Search button to search for contacts that fulfil the Search criteria. 

9 Double-click on the Contact to open it for review/amendment.

To create a custom view:

1 From the Views dropdown list, select Custom View.

2 A list of custom views will be displayed.

3 To edit a custom view, select the view in the list and click on the  button.
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4 To create a new custom view, click on the  button.

5 Enter a View Name.

6 In the Search for field, enter the search criteria for this view.

7 From the in dropdown list, the field(s) in the contact data to search in.

8 From the Marketing Classes dropdown list, select the Marketing Classes to be 

included in the View. Only contacts assigned the selected Marketing Classes will be 

included in the View.

9 From the Sales person dropdown list, select the Sales Person to be included in the 

View. Only contacts assigned the selected Sales Person will be included in the View.

10 From the Advert/Source dropdown list, select the Advert/Source to be included in 

the View. Only contacts assigned the selected Advert/Source will be included in the 

View.

11 From the Contact List dropdown list, select the Contact List to be included in the 

View. Only contacts assigned the selected Contact List will be included in the View.

12 Click on the  button.

New Contact
If the contact you are looking for is not there, you can create a new contact.

Contacts - Create new custom view
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To create a new contact

1 From the Contacts screen, click on the New button. A blank screen will appear, 

ready for you to enter information into the details tab of the account.

2 Enter the contact’s name in the order First name / Last name (e.g. Jane Smithson).

N O T E

If you want to add a salutation (e.g. Ms, Mr) and check the order of the name, click on the 

ellipsis (...) next to the name field. This will enable you to enter the contact’s Salutation, 

First name and Last name separately.

3 Enter the Postal Address. Street, City/Town, State and Country are broken down 

into separately lines.

T I P

Click the  icon in the toolbar and choose to copy either the company postal address or company 

delivery

4 Enter the post code into the Post Code field. Click on the ellipsis (...) to search for a 

postcode using the suburb name.

5 Enter the Delivery Address (if different to Postal Address). There are two additional 

lines which could be used for specific delivery instructions pertaining to the address 

(e.g. nearest cross street Digby Drive). If you do not enter a delivery address the 

postal address will be replicated on most reports.

New Contact entry screen
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6 Enter an email address. If this contact is to become the default contact for a 

debtor/creditor account, this is the address that will be used for emailing invoices 

and statements, remittance advices, etc.

7 Enter Phone Numbers including any relevant area codes. 

8 Select the option Sync with Outlook to synchronise this contact with Outlook every 

time a synchronisation is performed.

N O T E

Refer to the EXO Business User Guide or Online Help for more information on Outlook 

synchronisation.

9 Assign a Sales Person from the dropdown list.

10 Nominate an Advert/Source. Choose from the dropdown list of referral sources.

N O T E

The Advert/Source list can be edited by clicking on the Setup button next to the field. Click 

on the New button to add a new referral source and then click on Save. Close the window 

to return to the Account Contacts screen.

11 Enter an MSN id, Yahoo id and Skype ID as appropriate.

12 Enter the contact’s Facebook, LinkedIn and Twitter details to display information 

from these social media services in the Social tab.

13 Click on the Save on the toolbar. This will save the contact details entered so far and 

display the rest of the tabs on the Contacts screen. These include Marketing, 

Invoices, Orders, Notes, History Notes, Docs, Accounts, Relationships, Activities, 

Opportunities and Social.

T I P

Click on the  icon to sychronise this contact with your Outlook contacts.

Other contact information
Once you have saved your contact, additional tabs become available for entry of 

information and review.

Contacts > Marketing

The Marketing tab provides the facility to set up groups for marketing purposes that are 

independent of a contact’s membership in any other account or pricing group.

A contact can be a member of more than one marketing class and up to 26 marketing 

classes can be set up.
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Click on the  icon on the toolbar to create new marketing classes or edit 

the names of existing classes. If you are planning to change the name of a marketing class, 

make sure that the existing contacts assigned to that class are still relevant.

Contacts > Invoices tab

The invoice tab lists all the debtor or creditor invoices that relate to this contact. You can 

drill down from here to view more details.

Contacts > Orders tab

The orders tab lists all sales or purchase orders that relate to this contact. You can drill 

down from here to view more details about the order.

Contacts > Notes tab

The Notes tab allows recording of any general information relating to the contact. Click on 

the  in the toolbar to automatically insert date, time and your username, then 

enter details as required. This will provide a simple list of entries that can be printed if 

required by clicking on the  on the toolbar.

Setup Marketing Classes
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Contacts > History Notes tab

The History notes tab provides a more structured method for note taking. The top half of 

the screen provides a list of the history notes sorted by Date. The lower half shows the 

details of the note that is currently selected.

Click on the  button to create a new history note.

History notes can be emailed. Open the history note and click on the  icon 

to email the note to the contact or to a third party.

History Notes can be printed. Open the history note and click on the  button in the 

toolbar. This will print the history note to the default printer.

Contacts > Docs tab

The Contacts tab provides a list of all the documents that have been linked to the contact. 

These can be any type of file that is recognised by Windows, e.g. word processing, 

graphics or spreadsheet files. See later in this section on how to import a document to a 

contact.

Contacts > Accounts tab

The Accounts tab lists the accounts that are linked to this contact (e.g. a debtor or creditor 

account). From here you can drill down to the assigned account to look further into the 

transaction history if required.

Refer to ‘Linking Contacts with a company’ on page 54 for details on linking contacts to 

accounts.

History Notes Screen
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Contacts > Relationships tab

The Relationships tab allows you to create links between contacts (in addition to any links 

they may already have with a debtor or creditor account). You can setup different 

relationship types depending on your business requirements. The following example 

shows that Jane Smithson is a contact for Aussie Spares, as well as manager of Allan Ballot 

who is also a contact for Aussie Spares.

To establish a relationship:

1 Go to the Relationships tab of the contact for which you want to establish a 

relationship.

2 Right-click on the contact and select New.

3 Select the appropriate Relationship Name (i.e. employee, manages). The 

relationship name that you choose defines the list that the system puts forward:

• Manages returns a list of contacts

• Employee returns a list of existing staff members for the organisation

• Key Stakeholder returns a list of creditor accounts

• Supplies to returns a list of contacts

• Alternatively, you can setup a new relationship category.

4 Click on the ellipsis (...) to search a list of contacts/accounts to define the 

relationship with. Double-click on the appropriate entity and the relationship will be 

established. The corresponding relationship will also be established in the second 

account.

N O T E

To remove a relationship simply right-click on the contact/account and select Remove.

You can define new relationship types to suit your business

Relationship tab under Contacts screen
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To set up new relationship category:

1 Go to the Relationships tab of an account.

2 Right-click on the contact name under the Relationships tab 

3 Select Setup relationships.

4 Click New to setup a new relationship.

5 Choose the Entity source and the Entity destination (contact, customer, supplier, 

non-account, staff).

6 Define the relationship name and the inverse relationship name.

7 Assign an image, if required, by clicking on the arrow next to the Default Image 

button. If you want to revert to the system defined image, click on the Default 

Image button.

N O T E

When creating new relationships the relationship name will appear in the relationships 

screen of the source contact (or account), while the invers rel. name will appear in the 

relationships screen of the destination contact (or account). There is no need to establish 

the relatfionship twice.

Contacts > Activities

The Activities tab lists all the existing tasks/appointments that relate to the contact. You 

can also enter new tasks/appointments relating to the contact from this tab. Refer to the 

section ‘Working with Activities’ on page 62 for more information on Activities.

Set up Relationships
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Contacts > Opportunities

The Opportunities tab lists all the existing opportunities that relate to this contact.

N O T E

Opportunities are part of the functionality available with EXO CRM. The Opportunities tab 

can be added to the Creditor Account maintenance to enable users to use this 

functionality from within EXO Business core. However, an EXO CRM license will be used by 

each user that has access to this functionality from within EXO Business core. 

Contact > Social

The Social tab lists information about the contact from various social media services. If no 

social media details have been entered on the Details tab, the sub-tab will display the 

results of a search for the contact’s name. 

Linking Contacts with a company
Once you have setup a new contact, you can assign it to a debtor, creditor or non-account.

To associate a contact to a debtor, creditor or non-account:

1 Open the account you wish to assign the contact to.

2 Click on the Contacts tab. 

3 Once in the contacts tab you can either assign and create a new contact, or you can 

associate an existing contact to the account:

Action Description

Associate a new contact • If the contact does not already exist on the 

database, click on the  icon in the toolbar 

of the Contacts tab.

• The new contacts screen will appear with the 

company details already completed. 

• Enter the contact details as required and click 

on  to assign to the account. 

• Click the  icon in the toolbar of the new 

contact screen to copy the company’s 

address to the contact address.

Associate an existing contact • If the contact you wish to associate is already 

on the database, click on the  icon. 

• Search for the contact and then double-click 

the contact to assign it to the account.
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Any contact can be assigned default contact status, however there can only be one default 

contact per account. 

To assign default contact status:

1 Open the account for which you wish to assign default status.

2 Click on the Contacts tab.

3 Make sure that the correct contact is highlighted then click the  icon.

Synchronising Contacts
EXO Business integrates with the Microsoft Outlook Express client for the two-way 

synchronisation of Events (Tasks and Appointments).

I M P O R T A N T

Synchronisation with Microsoft Exchange Server is not supported.

To synchronise Contacts:

1 Double-click on the contact record.

2 Click the  button.

3 Right-click on the Contact and select Synchronise to Outlook.

N O T E

Outlook contacts will be sorted under their first name. Check with your system 

administrator to resolve this if required.

When Contacts are synchronised, the following updates occur:

• Any new Contacts in EXO Business are exported to Outlook. 

• Any new Contacts in Outlook are imported to EXO Business.

• Any existing Contacts that have been modified in EXO Business are updated in 

Outlook.

When synchronising Contacts, EXO Business is always used as the master database, i.e. 

the details of Contacts in EXO Business overwrite the details of the corresponding 

Contacts in Outlook.

Emailing Contacts
Account > Contacts > Documents

There are two methods for sending an email to a contact within MYOB EXO Business:
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• The first method is simply a link to your default email program and does not keep a 

record in EXO Business. 

• The second method will keep a record in the history notes section of the Contacts 

screen.

To email a contact:

1 Open the Account Contacts screen and search for the required contact.

2 Click on the Docs tab of the contact.

3 Click on the  icon in the toolbar. This will open your default email program 

(e.g. Outlook) and enter the contact’s email address in the To field.

4 Complete the rest of your email and send it according to your default email 

program.

5 Once the email is sent, you will be prompted to save a copy of the email in the 

contact’s documents.

To email a copy of a History Note to a contact:

1 Open the Account Contacts screen and search for the contact.

2 Click on the History Notes tab of the contact.

3 Start a new history note by clicking on the  icon in the toolbar.

4 Complete history note by entering the subject and details into the history note.

Email a History Note
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5 Email the History note by clicking on  in the toolbar. This will open 

your default email program (e.g. Outlook) and enter the contact’s email address in 

the To field. The subject and content of the history note will also be entered 

automatically into the email. Complete the rest of your email and send it according 

to your default email program.

6 Once the email is sent, you will be prompted to save a copy of the email in the 

contact’s documents.

Attaching documents
Accounts > Contacts > (Contact Name) > Docs

Documents can be attached to contacts or accounts. They can be linked to the database 

(using less memory) or saved into the database (more memory).

To import a document:

1 Open the Docs tab on the Contact screen.

2 Click on the  icon and then on New.

3 Click on the  icon on the toolbar.

4 Navigate to the document you wish to import and double-click to open.

5 Choose how to connect the file:

• Save as a Link Only (linking is the recommended method as it uses less space within 

the database).

• Save file to database.
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6 Enter referencing details into Document Manager (the document date, file name 

and source path will be automatically entered).

7 Click Save. 

The document is now linked to the database and visible from that contact. It can be 

opened and edited as required.

Document Manager
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Non-Accounts

In addition to contacts that are not connected to a debtor or creditor, MYOB EXO Business 

provides for companies that are not either a debtor or creditor. 

These are referred to as Non-accounts and could be a prospect or business associate with 

no suppliers / customer relationship. 

Generally you will not have a trading relationship with a Non-Account. However, if that 

situation changes, you can easily convert a Non-Account to a debtor or creditor account. 

N O T E

Activities can be setup for Non-Accounts and contacts can be associated with Non-

Accounts.

New Non-accounts are set up the same way that a debtor account or a creditor account 

would be set up.

To set up a new Non-Account: 

1 From the Account menu, click on Non-Accounts.

Non Account
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2 Click New to create a new non-account. 

3 Enter the name, contact details, etc.

4 From the Type dropdown list, the default option non-account will be available. 

Select Edit List... to add additional account types to the list.

• Click New to create a new non-account type.

• Enter the details of the non-account type and click on Save.

5 An Account Template can be selected for the Non Account. When the Non Account 

is converted to a debtor or creditor, the assigned account template will be used as a 

basis for creating the debtor or creditor master record. Click on the  button to 

search for and select an account template to assign.

6 From the Base price dropdown list, a price can be assigned to the non account.

7 Click on the  button to assign a Sales Person to this account.

N O T E

If EXO CRM is installed and licensed, a field will be available to track the Campaign Wave 

that generated this Non Account.

8 In the Facebook, LinkedIn and Twitter fields, enter the company’s Facebook, 

LinkedIn and Twitter details. Information about this company on these social media 

services will be displayed in the Social tab.

9 In the Notes field, enter any notes pertaining to this non account.

Set up Company Type
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10 Click on the  button.

T I P

Once you have saved the Non Account, the Contacts, History Notes, Activities, Relationships, 

Documents and Social tabs will be available.

To convert a Non Account to a Debtor or Creditor:

1 From the Accounts menu, click on Non Accounts.

2 Double-click on the record you want to convert.

3 In the Non Account Details screen, click on the  to convert the non 

account to a debtor.

4 In the Non Account Details screen, click on the  to convert the non 

account to a debtor.

5 Once the non account is converted, you will be presented with the Debtors or 

Creditors Maintenance screen respectively.
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Working with Activities

The Activity Search widget is a useful tool in EXO Business that enables you to create 

activities (tasks or appointments) and assign them either to yourself or another staff 

member. 

These activities can be linked to any accounts (debtor, creditor, non account) or contacts. 

When an activity has been entered for an account or contact, it will appear in the activities 

tab of that entity.

Activities operate in a manner similar to Microsoft Outlook with tasks and appointments 

treated similarly to tasks and appointments in Microsoft Outlook. Tasks and appointments 

can be scheduled, set as recurring, and categorised in a way that suits you and your 

business.

Activities can also be synchronised with Microsoft Outlook. When synchronising Activities, 

the distinction between Tasks and Appointments is preserved, e.g. Activities that exist as 

Tasks in EXO Business will appear as Tasks in Outlook after Activities are synchronised.

The Activities view displays all Tasks and Appointments in the EXO Business system. 

Activities can be displayed in a simple list, or on a calendar interface.

Set up Calendar
Events are presented in a calendar style view that can be customised to suit your own 

requirements. You can vary the increments in which you view the time and can have up to 

two time zones appearing on your calendar. 

You can set up various viewing options in the Setup Scheduler screen.
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To set up the calendar:

1 Select Setup Calendar from the Tools menu.

2 Setup the appropriate options such as:

• work days and work times to calculate task durations 

• time scale in which to view your tasks and calendar (e.g. half an hour, 15 minutes, 

etc).

• first day of the working week

• an additional time zone to appear on your calendar, if required.

3 Click Ok.

Review Activities
T I P

Individual activities can be reviewed in the activities tab of any entity (contact, creditor, debtor, non 

account) that they are related to.

Set up Task Scheduler
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List View

Selecting the List View option (found under the  button in the Activities Search 

widget) displays all Tasks and Appointments in a simple list. 

For easy idenfication, activities are colour-coded:

• Green background = Tasks

• No colour background = Appointments

To edit an activity:

1 Double-click on the activity.

You can select a pre-defined view from the Views dropdown list to apply a filter:

To create a custom view:

1 From the Views dropdown list, select Custom View.

2 A list of custom views will be displayed.

3 To edit a custom view, select the view in the list and click on the  button.

Activities - List View

View Description

My Activities Lists all the activities where the current user is the 

creator of the activity.

Open Activities Lists all the activies with a status other than Completed.

Closed Activities Lists all the activities with a status of Completed.

Overdue Activities Lists all activities with an End Date prior to today.

Today’s Activities Lists all activities with an End Date of today.

Tomorrow’s Activities Lists all activities with an End Date of tomorrow.

Custom Views Custom views will be listed next. Select the option 

Custom Views to create a customised view for the 

current user.
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4 To create a new custom view, click on the  button.

5 Enter a View Name.

6 In the Search for field, enter the search criteria for this view.

7 From the in dropdown list, the area in the activity to search in.

8 From the Activity Type dropdown list, select whether the search should be 

conducting in Appointments only, Tasks only or All activities.

9 From the Type dropdown list, select the type of activity to include in the search. The 

options displayed on this list will depend on the selection made in the Activity Type 

dropdown list.

10 From the Priority drop down list, select the priority assigned to the activity.

11 From the Status dropdown list, select the status assigned to the activity.

12 To apply a specific date range to the view, select the option for the Start Date 

and/or End Date.

Activies - Create new custom view
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13 Select the operator to apply to the date entered:

14 From the Assigned To dropdown list, select the user the activity is assigned to.

15 From the Assigned By dropdown list, select the user created the activity.

16 Click on the  button.

Calendar View

Selecting the Calendar View option (found under the  button in the Activities 

widget) displays Tasks and Appointments in a calendar view similar to the Task Scheduler 

in the EXO Business core module.

You can select a pre-defined view from the Views dropdown list to apply a filter:

Operator Description

= The Start Date or End Date is the same as 

the date specified.

<> The Start Date or End Date is prior to or after 

the date specified.

< The Start Date or End Date is prior to the 

date specified.

<= The Start Date or End Date is prior to or the 

same as the date specified.

> The Start Date or End Date is after the date 

specified.

=> The Start Date or End Date is the same as or 

after the date specified.

Between The Start Date or End Date is the between as 

the dates specified.

Activity Views - Days
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Activity Views - Year

Activity Views - Time Grid

Activity Views - Week
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Appointments appear on the calendar, while Tasks are listed in the section below.

To edit an activity:

1 Double-click on the activity.

Right-clicking on an activity provides the following options:

Activity Views - Month

Option Description

Postpone Delay the activity by the specified amount of 

time.

Mark as completed Change the Status of the selected activity to 

Completed. This can also be achieved by 

editing the activity and clicking on the 

 button on the toolbar.

Selected Items > Export to 

Outlook

Synchronise the selected activities with 

Microsoft Outlook.
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Creating new activities

To create a new activity:

1 Click on the New button.

2 From the Activity Type dropdown list, select either Appointment or Task.

3 Select the Type of event (estimate, new business, to do, etc). This list can be edited 

by selecting the option Edit List.

4 Select the option Sync with Outlook to synchronise this event with the 

corresponding type in Outlook.

5 Enter the Subject details - this will appear in the task scheduler window.

6 To link the task to a company, enter the Company.

7 To link the task to a contact, enter the Contact.

N O T E

If EXO CRM is installed and licensed, fields will be available to track the Opportunity and 

Campaign Wave that generated this Activity. A double Click on the campaign will open up 

the campaign for a user with EXO CRM access.

New Task Screen
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8 Enter a Label as required (Important, Personal, Must Attend, etc). These options 

cannot be edited.

9 From the Status dropdown list, select the appropriate status for the activity (In 

Progress, Completed, Deferred, etc). This list can be edited by selecting the option 

Edit List. If the % Completed is set a value between 0.00% and 100.00%, this field 

will be automatically set to In Progress.

10 To assign the activity to another staff member or multiple staff members, select 

their name from the Assigned To dropdown. The activity will appear in their own list 

the next time their screen refreshes. 

11 Select a Priority of Low, Medium or High. These options cannot be changed.

12 If the Activity Type is set to Task, a % Complete field will be available to track the 

progress of the task. Depending on the Status, this field will be automatically set to 

one of the following:

13 A Reminder can be set to provide an alarm at the designated time prior to the 

scheduled event start.

14 Amend the Start and End Time/Date as required, or click on the  icon in the 

toolbar to set up a recurring evejnt. (The following shows a regular event from 8.30 - 

9.00 every Wednesday for 10 weeks.)

15 Add Notes to the activity as required in the lower panel.

Status % Complete

Not Started 0.00%

Completed 100.00%

Any other option 25.00%

Task Recurrence Screen
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16 Click Save & Exit or Save & New to save the activity.

The Calendar view offers several options for creating new activities:

• Clicking on the New button.

• Double-clicking on a time slot on the calendar to create an activity at that time.

• Right-clicking on a time slot on the calendar to create an activity at that time. 

T I P

The right-click menu also  contains options to create an all-day activity or a recurring activity.

• Double-clicking on a blank area of the Task list.

Synchronising activities with Outlook
EXO CRM allows activities (Tasks and Appointments) to be synchronised between MYOB 

EXO Business and Microsoft Outlook. When activities are synchronised, the following 

updates occur:

• Any new activities in EXO Business are exported to Outlook. 

• Any new activities in Outlook are imported to EXO Business.

• Any existing activities that have been modified in either system are updated in the 

other system.

In all cases, the distinction between Tasks an Appointments is preserved, e.g. activities 

that exist as Tasks in EXO Business will appear as Tasks in Outlook after activities are 

synchronised.

I M P O R T A N T

When updating existing activities, the synchronisation process uses the most recently 

updated activity as the "master" and copies this to the other system. This means that if the 

same activity is edited in both systems before activities are synchronised, only the most 

recent changes will be saved.

T I P

Separate Import from Outlook and Export to Outlook functions are also available to perform a one-

way synchronisation of Activities in either direction.

To synchronise all activities in a specified date range:

1 Click the  Tools button on the toolbar and select Sync Activities with Outlook.
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2 The following window opens:

3 Specify which activities to synchronise by selecting one of the following Date 

options:

4 Click OK.

To synchronise specific activities in the List View:

1 Click on the selection boxes of all activities you want to synchronise.

2 Right-click anywhere on the list and select Selected Items > Export to Outlook from 

the pop-up menu.

Functions are also available to perform a one-way synchronisation of activities:

• Click the Tools button and select Import Activities from Outlook to import activities 

from Outlook.

• Click the Tools button and select Export Activities to Outlook to export activities to 

Outlook.

Sychronise Activities with Microsoft Outlook

Date Option Description

All All the activities will be synchronised with Outlook.

Today Only today’s activities will be synchronised with Outlook.

From Today Only activities from today onwards will be synchronised 

with Outlook.

Date Range Enter a specific date range of activities to synchronise with 

Outlook.
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Respond to reminders
If a reminder has been set, at the designated time you will receive a reminder of the 

activity via an alarm icon ( ) on the tast bar of your windows screen. Double click on the 

alarm icon to bring up the reminder window.

You can respond in one of four ways:

• Dismiss All will dismiss all reminders in the reminder screen.

• Open Item will open the task for review and editing.

• Dismiss will dismiss the currently selected reminder.

• Snooze will enable you to ‘‘snooze’’ and be reminded again in the specified 

timeframe (10 minutes by default).

Task Reminder Screen
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Setup a new Creditor

Accounts > Creditors

The creditor screen is very similar in layout to the new debtors screen. While the process 

for setting up a new creditor is relatively straightforward, you will need to consider a 

number of additional factors such as what groups the creditor will belong to, the credit 

terms available from that creditor, payment defaults, etc. These issues can be discussed 

with your implementing partner or systems manager.

To set up a new creditor:

1 Navigate to the creditors search screen via the drop down menus Account > 

Creditors.

2 Search for the creditor by typing part of the creditor name and pressing Enter to 

check that they are not already entered.

3 Click on the New button to create a new creditor.



© Copyright 2013 MYOB Technology Pty Ltd

Unit 2—Account Masters

 75

Details 1 tab

1 Enter Primary Details:

New Creditor: Details 1 tab

Section Description

Account name & Code EXO Business will generate a code based on the name 

that you give the creditor. This can be overwritten if 

required.

Delivery and Postal Address Ensure that you enter the details in the correct fields 

(use the Enter key). If you choose not to enter a 

separate delivery address, then the postal address will 

be replicated once the creditor account is saved.

E-mail, Phone, Contact Name To enter a contact name on the Details1 screen, a 

contact must first be entered into the Contacts tab. 

Then click the  icon in the menu bar. ‘Working with 

Contacts’ on page 45 to review the procedure for 

adding a contact.
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2 Review Account Flags checkboxes:

Extra fields - Default Code This enables you to specify a default GL account code to 

be entered automatically when generating a new 

invoice or purchase order for this creditor. For example, 

you may like to assign your cleaning company the 

default code of 3250: Cleaning.

Purchasing Groups Primary and Secondary purchasing groups are setup by 

your implementing partner. Ensure that you select the 

correct ones so that reporting and purchasing activities 

are based on accurate information.

Credit Terms The different credit terms available have been set up by 

your implementing partner. Choose the appropriate 

period and credit limit that applies for this creditor.

Currency Enter the appropriate currency. It will default to AUD 

(for Australian databases) or NZD (for New Zealand 

databases).

Note: Make sure that the currency is correct as it 

cannot be changed once the creditor account is saved. 

If the currency changes a new creditor should be 

opened.

Option Description

Active Select to make the account active.

Open Item Enables the allocation of payments to specific invoices.

Stop Credit This option enables you to stop invoices being posted to this 

account.

Private Account This option restricts access to designated staff only.
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Details 2 tab

1 Enter Secondary Details:

New Creditor: Details 2 tab

Section Description

Default payment type This must be cheque or D/Credit for the creditor 

account to appear in Creditors Payment Processor.

Bank, Branch, Account, Suffix These details are used when using the direct credit 

feature in Creditors Payment Processor.

GST number Note: The GST is not a required field so MYOB EXO 

Business will not remind you if it has not been 

completed.

Override GST Rate It is recommend that the GST rate is left at 1-Auto 

Select Rate. This will utilise the default rate for 

creditors that is set up during implementation. 

Refer to your implementation partner or system 

supervisor if you are unsure.
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Extra Fields
If any extra fields have been set up for your organisation, enter the information as 

appropriate under the Extra Fields tab.

Click on the Save button to save the account details. Other tabs will now be available to 

enter additional information (such as Contacts, Transactions, Orders, Relationships, 

Activities, etc). Information about these tabs has been discussed in prior sections.

Assign a Contact
Once you have entered and saved the basic creditor details, additional tabs become 

available for entering further information. Refer to ‘Working with Contacts’ on page 45 for 

details about entering contacts and assigning contacts to an account.

Default Invoice mode This specifies whether new invoices created for 

this creditor will be stock invoices or default to GL 

codes. Refer back to the Details 1 tab to enter a 

specific default code (i.e. Rent and Rates).

Primary Lead Time Delivery lead time in days.

Secondary Lead Time Alternative delivery lead time in days.

Prompt Payment Discount (%) Enter a prompt payment discount % for this 

creditor. A prompt payment discount calculation 

button will become available on the creditor 

payment screen when making payments to this 

creditor within the prompt payment timeframe.

Remittance Method From the dropdown list, select the method used to 

send remittance advices to this creditor. (Print/E-

mail)

Remittance Contact From the dropdown list, select the contact to 

which remittance advices will be sent if the 

Remittance Method is set to E-Mail

Pop-up Alert This field allows you to enter an alert (such as 

‘‘check for sale items when ordering’’ or ‘‘only 

order through John’’ to appear when entering 

transactions to this account.
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Create a new Debtor record

Create a new Contact

Create a new Non-Account record

Create Activities

Create a new Creditor record
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Reports & 
Dashboards

In this unit you will learn 
the basic functionality to 
access reports and create 
and utilise dashboards 
layouts.

By the end of this unit, you will be able to:

Print, view and export standard reports using 

Clarity Report Browser and the Dashboard.
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Reports

EXO Business’s reporting capacity is extensive and there is a vast number of standard 

reports available. In addition there are a number of tools which allow you to customise 

and design your own reports and forms as well as produce graphical analysis of 

information.

Available reports can be viewed via:

Clarity Report Browser

The Clarity Report Browser shows all available reports categorised into functional areas. 

Reports can be previewed, run or added to a user’s menu as required.

Dashboard

The Dashboard enables each user to display data using widgets created in EXO Analytics.

Functional menu reports drop down

The functional menu reports drop down is located on the lower left hand corner of the 

main screens (ie Sales, Purchases, Stock, etc). The drop down will show reports that relate 

to the screen you are currently viewing. For example, on the Sales screen the reports drop 

down will show reports that relate to either Sales, Sales Orders or Debtors. Individual 

reports can be selected from the drop down menu.

EXO Analytics

EXO Analytics presents a customisable overview of the organisation’s business status. It is 

intended for use by management to monitor business performance.
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Customise/edit reports

Sales Analysis Designer

The Sales analysis designer accesses a core of eight basic report types which can be used 

to analyse sales. Two groupings can be used, and sales can be grouped by stock (primary 

and secondary group), debtors (primary and secondary group), location, branches or sales 

rep. Multiple selection criteria / conditions can also be incorporated into the analysis.

N O T E

Refer to the EXO Advanced Reporting training manual for instructions on how to set up 

and use the Sales Analysis Designer.

Clarity Report Designer

The Clarity Report Designer is a complex utility which can be used to modify existing 

reports and forms or create entirely new ones. It accesses data from the database tables 

and presents them using a completely customisable format.

While there is a whitepaper on using Clarity Report Designer, it is generally recommended 

that interested users attend separate training in Clarity before attempting to generate 

new reports.

GL Report Designer

The GL Report Designer enables users to create or modify existing General Ledger reports 

such as P&L, Budget Analysis and Balance Sheet to suit their own requirements. Once 

reports have been designed or modified they can be run individually or run via a GL Report 

Batch. Modifying and running GL reports is covered in more detail in the General Ledger 

and End-of-Period Processes.

Run reports
Clarity reports are predominantly run from either the Reports menu or the Clarity Report 

Browser.
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1 Open the Clarity Report Browser from the Reports menu.

2 Select the report and click on the Run Report button.

T I P

To view a preview of the report, click on the  icon. This will display a pdf preview of the 

selected report.

Clarity Report Browser
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3 Depending on the report you have chosen, certain parameters will need to be set. 

The following shows parameters for a stock sales report:

T I P

Select the DESC. option next to Order By: to sort the report in descending order.

N O T E

Many reports allow the use of Analysis Codes. If codes are recorded against source 

transactions and selected as a parameter in the report, then reports show only those 

transactions that the analysis code has been applied to. Up to two analysis codes can be 

chosen per report.

Report Parameters for Stock Sales Report
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4 Once the report has been chosen and the appropriate parameters set, you can 

choose how you wish to view the information in the report. Click on the appropriate 

toolbar icon to:

If you have selected View as a Grid, you can right click on the header of the ExoGrid and 

copy the report data to the clipboard for easy pasting into your spreadsheet or other 

document:

Print

Preview on screen

Export to a file for review

View as a grid

Email a pdf copy of the report

Export 

Copy to Clipboard function
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Add Clarity Report to Reports Menu
Reports can be added to your reports drop down menu via the Clarity Report Browser.:

1 Open the Clarity Report Browser from the Reports tab.

2 Right-click on the report you wish to add to your menu and select add this report to 

MY Menu.

3 Change the caption so that it reads the name of the report you wish to add (e.g. Tax 

Rate List)

4 A REPORTID= procedure can be specified. If this parameter exists the specified 

report will appear as the default selection.

Sample Clarity Report: Stock Sales
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5 Choose the menu location for the report.

6 Click Ok.

Add Clarity report to menu
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Using Dashboards

The Dashboard is launched from the Reports tab.

The Dashboard enables individual users to set up their own series of dashboards using 

widgets created in EXO Analytics.

T I P

Clicking on summary data in the Dashboard drills down to source data. This provides even greater 

detail on specific items “at a glance”.

Create a Dashboard Layout
1 Launch the dashboard utility via Reports > Launch Dashboard.

Sample Dashboard



© Copyright 2013 MYOB Technology Pty Ltd

Getting a head start with EXO Business EXO Business

 90

2 Click on the  icon. You will be presented with a list of widgets available to you.

3 Select the widgets you wish to have available on your dashboard layout.

4 Click on Ok.

5 Click on the  icon to select the widget(s) to display on your dashboard.

6 Click the  icon in the toolbar to save your layout (e.g. Demo Layout).

T I P

A user can set up more than one Dashboard layout to be accessed as required. You could set up a 

“Sales” dashboard as well as a “Finance” dashboard to be opened and viewed separately.

Manipulate Widget Layout
Once a Dashboard layout has been created, you can change the way that you view the 

widget on the screen.

Resize a widget by clicking and dragging on the border of the report.

Move a widget to a new position by clicking and dragging on the blue report header. 

Hover your mouse over the  icon to snap the widget to a specific position.

Click on the  icon to reset the widgets to the default layout.

List of Widgets available to you
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Remove widgets from the layout view by unselecting them from the list in the  icon as 

shown below (select again to bring back into view).

Print or Export Widgets
The Dashboard is primarily designed to view reports on screen to provide an overview of 

key areas of responsibility for the individual user. At times it may be appropriate to print 

or export Dashboard reports. This can be done via the individual widget utility dropdown 

on the individual report as shown below.

New widgets can be creating using EXO Analytics. Refer to ‘Analytics’ on page 92 for more 

information.

Dashboard view selection

Printing Dashboard reports
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Analytics

Analytics is launched from the Reports tab.

Analytics

EXO Business Analytics presents a customisable overview of the organization's business 

status and is intended for use by management to monitor business performance.

N O T E

For more information on using Analytics, including creating widgets, refer to the EXO 

Business Advanced Reporting training manual.

Sample Analytics screen
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Skills checklist

Tick the skills that you have learned in this unit.

Skills

Run reports using the Clarity Report Browser

Add Clarity Reports to report menus

Create a Dashboard Layout
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Getting Started - 
Review

This unit provides a list of 
questions to review what 
you have learned.
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1 Name at least two ways in which Exo Business is different to other programs you 

have used?

2 What are the main account masters called?

3 Name three shortcut keys you are most likely to use?

4 What is the meaning of the different colours when listing debtor or creditor 

accounts?

5 How can columns be added to an Exogrid?

6 When resizing windows to suit your workspace, how can you save the new windows 

size and position?
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7 Give two reasons why you might use History Notes rather than Notes when entering 

extra information about a supplier?

8 Where would you look for a quick overview of sales to a particular debtor?

9 How can tasks be exported to Outlook.

10 How will you quickly access your most commonly used reports?

11 Where would you look to see all available reports on the system?
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Getting Started - 
Activities

This unit will provide you 
with a list of activities to 
practice the processes 
covered.
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Activity 1 - Log in, search and manipulate exogrid
• Log into the Exonet training database using the User and Password of DEMO.

• Open a list of DEBTORS and sort by, PRIMARY GROUP and then by ACCOUNT NAME 

Hint: Use Shift key to multiple sort.

• Maximise the screen to the full window size and save the Window size.

• Move the BALANCE column so that it appears next to the debtor name and resize the 

balance column so that is narrow.

• Save the column settings 

HINT: Right click on Exogrid header.

• Exit the debtors screen and go back in. Are the changes you made to the column 

settings still visible?

Option 1a: Debtors>File>Advanced Search

• Search for all debtors with a current balance greater than $5000. 

HINT: go to FILE > ADVANCED SEARCH Market Parts

Option 1b:

Keeping your result from activity 1a, add an additional filter.:

• Search for all debtors from the Sydney area. 

Hint: Use Address 3 not Address 4.

Activity 2: Search for transactional information
• Open the debtor account JAMES BARRY.

• What is the BALANCE owing on this account?

$998.29

• What was the TURNOVER for the account this year?

$0.00

• What PRIMARY GROUP is James Barry part of?

Retail
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• What INVOICES make up the outstanding balance?

Inv # 098N

• Click on GROUP BY PERIOD to view transactions on a period basis. What 

transaction/s occurred in Oct 2008

HINT: If you cannot view the transactions remove the tick from the SHOW ONLY 

UNALLOCATED checkbox.

Option 2a:

• Print the ACCOUNT DETAILS for the James Barry account and review on screen. Note 

summary information provided.

Option 2b:

• Change the credit terms to NET 7 DAYS and the default payment type to CHEQUE. 

Assign a prompt payment discount of 5% to the account.

Option 2c:

• Find the creditor account – G GRAY ACCOUNTANTS

• How much do Motopartz owe and on what invoice number? 

HINT: Remember to search CREDITORS and not Debtors.

Inv # 2400 $ 787.50
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Activity 3: Add a new customer/debtor
You collected the following business card from a new Customer – BOB JANE T-MART. Enter 

this as a new debtor.

Activity 4: New contact 
• Enter JANE SMITHSON as a new contact for Bob-Jane T-Mart.

• Make her the default contact.

Option 4a: Exporting contacts via clipboard

• Recall all contacts that have the marketing profile RETAIL CLIENTS

• Export to an Excel/Word file 

HINT: right click on the retrieved information and select “COPY TO CLIPBOARD”.

Primary Group Retail

Base Price Internet

Credit Terms 30th of the month with a $20,000 limit

Currency: AUD

Default email accounts@bobjanetmart.com.au

Prompt Payment Discount 2%

ABN 333 654 111

GST Rate 1 - Auto Select Rate

Default Payment Type Cheque
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Activity 5: Change default contact 
• Currently TERRI ECHURT is set as the default contact for the customer AUSSIE 

SPARES. You have been advised that she has left Aussie Spares and the new main 

contact will be ALLAN BALLOT.

• Assign Allan Ballot as the default contact.

• Remove Terri’s association from Aussie Spares. 

HINT: Do not delete this contact, simply use the minus icon to unassociate from Aussie 

Spares.

Activity 6: History notes 
• Enter a HISTORY NOTE to Terri Echurt’s account contact indicating that she is no 

longer with Aussie Spares: “Terri Echurt is no longer with Aussie Spares. All future 

enquiries should go to the new default contact – Allan Ballot”

• How will you Email the history note to your own email address?

Activity 7: Create task & export to Outlook 
• You have called Allan to congratulate him, and been invited to a celebratory lunch 

with the directors of Aussie Spares. Create a new task with the details:

• 16th of next month. 12.00 until 3.00pm at the Bathers Pavilion. 

HINT: search and enter the company name if you want the task to appear under the 

Aussie Spares task tab as well as Allan Ballot task tab.

• How will you Export the task to Outlook?

Option 7a: Recurring Task

• Establish a new recurring task for a regular Sales meeting on the 1st Tuesday of each 

month until the end of the year. Time frame is 8.30 – 9.30am.
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Activity 8: Non-accounts 
• Create a new non-account for the company 4 WHEELS, a prospective customer.

• Create and link a primary contact HENRY CHADWICK

• Put him into a new marketing class of 9: PROSPECTIVE CLIENTS. 

HINT: you will need to set up a new marketing class via the marketing tab of the 

contact.

Option 8a: Convert non-account

• Convert 4 Wheels to a debtor and assign the following fields.

Activity 9: New Creditor 
• Obtain a business card from the person sitting next to you. Enter them as a new 

supplier to Motopartz and assign the following fields.

Primary Group Retail

Base Price Retail

Credit Terms Cash Only

GST Rate 1 - Auto Select Rate

ABN 778 655 456

Default payment type Cheque

Prompt Payment discount 5%

Popup Alert New Customer - please make sure they get good 
service!

Primary Group Australia Wide
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Option 9a: Enter default contact

• Enter the person next to you as a default contact for the new supplier account.

Activity 10: Reports 
• Generate a preview of the report that shows the outstanding balances for all debtor 

accounts sorted by the outstanding balance. Which local currency customer owes the 

most and how much do they owe?

Debtor Aged Balances Report. Market Parts: $26,445.93

• Find the report DEBTORS STOP CREDIT LIST and add it to your main reports menu 

Hint: Use Clarity Report Browser and right click on the report. 

• Preview the report.

Activity 11: Create a personal Dashboard 
• Create a new Dashboard layout called MY DASHBOARD. 

• Incorporate the following reports (widgets) into the Dashboard:

Secondary Group Overhead

Credit Terms Net 21 days

Currency AUD

Email sales@xxxx.com

Default Code 3550 Rent & Rates

Default Payment Type Cheque

Default invoice mode GL

Primary Lead Time 4

Secondary Lead Time 1

ABN 67 543 123

Override GST Rate 1 - Auto Select Rate

• Top Stock by Margin

• Top Customer by Margin

• Period Sales Analysis by Branch
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• Reorganise the dashboard so that your personal choice report is in the upper left of 

the screen.

• Resize the widgets in the dashboard so that they are set to “Dashboard width” 

• Save the new dashboard layout.

• Review the available reports and select a fourth report to include in your 

Dashboard


